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Chapter 1: Getting Started Guide

1.1 Uninstalling Prior Versions
We recommend that you uninstall any prior version of E-Prime 2.0 before installing the new 
version. If you do not uninstall the software now, the installer will prompt you to do so before 
installation begins. We also recommend that you make a backup copy of any experiments or data 
you would like to save that use previous versions of E-Prime 2.0. The My Experiments folder will 
be refreshed when you open E-Studio for the first time after installation of the software. When this 
occurs, all of the Samples and Tutorials included in the E-Prime 2.0 installation are overwritten. If 
you have renamed any of the Samples and Tutorials, they will not be overwritten.
NOTE: E-Prime 1.x versions can be installed on the same machine as E-Prime 2.0.

For Windows XP
•   Open the Control Panel from the Start menu or from My Computer. 
•   Open Add/Remove Programs. 
•   From the list of installed programs, select E-Prime 2.0, and click the Change/Remove button. 
•   In the InstallShield Wizard dialog, select Remove. Click Next to continue, and click the 
    Change/Remove button. 
•   Click Yes to remove all components, and then click Finish. 

For Windows Vista
•   Open the Control Panel from the Start menu or from My Computer. 
•   Open Programs and Features. 
•   From the list of installed programs, select E-Prime 2.0, and click the Change button. 
•   Click Continue in the User Account Control dialog. 
•   In the InstallShield Wizard dialog, select Remove. Click Next to continue. 
•   Click Yes when prompted to remove the selected application, and then click Finish.

For Windows 7
•   Open the Control Panel from the Start menu or from My Computer. 
•   Open Programs, then select Programs and Features. 
•   From the list of installed programs, select E-Prime 2.0, and click the Change button. 
•   Click Next in the InstallShield Wizard dialog.
•   In the InstallShield Wizard dialog, select Remove. Click Next to continue. 
•   Click Yes when prompted to remove the selected application, and then click Finish.
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1.2 Software Installation
Before continuing, be sure that you have administrative rights to install this software on the 
computer. If you do not have administrative rights, you will be unable to install E-Prime 2.0. 
If you are unsure of your administrative privileges, contact your System Administrator. 
NOTE: The current version of E-Prime 2.0 will uninstall any older versions prior to installing the 
new version. The version number on the following images may not correspond to the version 
number on your software. 

 3

  3
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1  

1)  Insert the E-Prime installation CD
     into your CD-ROM drive. Click the
     Install button to continue
     installation.
        If the CD doesn’t automatically 
        launch, you can go to your CD 
        drive and launch it from there.
        NOTE: Prerequisite system
        components may be installed at
        this point, which may require a
        system restart. After restarting
        your computer, reinsert the CD to
        restart the E-Prime 2.0
        installation. 

2)  Click the Next button to continue
     installation.

3)  Please read the License
     Agreement and make sure you
     agree completely with the terms
     and conditions described in the
     agreement before accepting the
     terms. Once you have read the
     agreement, click Next to proceed
     with the installation.
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4)  Specify Your Name and
     Your Institution or check with your
     system administrator for appropriate
     information. 

5)  Enter your E-Prime 2.0 Serial
     Number.
        NOTE: Before using E-Prime, you
        must complete both the Installation
        and Registration and Validation
        processes in section 1.3
        Registration and Validation. Your
        serial number and hardware key
        will be required (some installations
        use a hardware key connected
        to the network, and will not require
        a physical key).

6)  Click Next to continue installation.

7)  Select Complete to install the
     complete E-Prime 2.0 suite.

8)  Click Next.

9)  Click Install to begin transferring
     files to your computer.

 9
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10)  Wait while the installer configures
       the software. 
        The E-Prime installer may prompt
        you to install\update additional
        drivers at this point. Please install
        them and continue with your
        installation. 
        NOTE: If you are instructed to
        reboot, do so and follow all
        prompts. You may have to restart
        the E-Prime installer once your
        reboot is complete.

11)   If E-Prime 2.0 is installed properly,
       you will see the following window. 

12)   Click Finish to complete
        installation.

11 

 12

 10
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1.3 Registration and Validation
1)   Connect the hardware key.
2)   Launch E-Studio (if not launched automatically by Setup).
3)   The E-Prime Auto Update screen appears. Click OK. 
4)   If you did not enter your serial number when prompted to do so during installation, the E-Prime 
	 Registration screen appears. Enter your name, institution, and serial number and click OK.
5)   If this is your first time opening E-Studio you will be prompted to accept the End User License 
	 Agreement. You must choose yes, and accept the agreement to proceed.
NOTE: If upgrading from E-Prime 1.x to 2.0, you will be prompted to insert your 1.x hardware key 
temporarily during the validation process. This is a one-time operation requiring the 1.x hardware 
key to validate the 2.0 hardware key. To start the validation process, install E-Prime 2.0 and follow 
the prompts. E-Prime 1.x installation is not required for validation.

1.4 E-Prime Resources
Where to find information
Currently, over 500 pages of documentation are available in various forms. We recommend that 
you work through the Getting Started Guide in its entirety. This provides the foundation for learning 
to use the applications which comprise E-Prime.

Getting Started Guide
The Getting Started Guide includes step-by-step tutorials to walk you through the basics of 
E-Prime.
•   Tutorial 1 — E-Studio (estimated time to complete: 40 – 60 minutes).
•   Tutorial 2 — E-Merge (estimated time to complete: 15 minutes).
•   Tutorial 3 — E-DataAid (estimated time to complete: 15 minutes).
•   Advanced Tutorials — Modifying  basic experiments to use image, sound, and movie stimuli as 	
    well as user-written script.

User’s Guide and New Features/Reference Guide
The User’s Guide and New Features/Reference Guide are included as PDF files on your E-Prime 
software CD. It is extremely useful to have the manuals as a reference point as you work through 
the system. Each volume contains valuable information that will help you master the applications 
within E-Prime.

Sample Experiments
Open, inspect, and run each program from the Samples folder
 (default installation ...My Experiments\Samples).
• BasicRT – text reaction time experiment
• PictureRT – picture reaction time experiment
• SoundRT – sound reaction time experiment
• SlideRT – combined text and image reaction time experiment using a Slide
• MovieRT – movie reaction time experiment
• NestingRT – allows selection of different word lists from different conditions
• NestingXRT – using extended responses, borders, colors, and inputs from multiple devices
• MultipleDisplayRT – using multiple monitor displays 
NOTE: The MultipleDisplayRT sample is only available in E-Prime 2.0 Professional.

It is recommended that you inspect and run at least one of the sample experiments. 
Consider making a simple modification to the experiment. 
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Resource Description Format Location

Getting Started 
Guide (this manual)

Quick reference for general 
information, step-by-step 
tutorials for each application 
within E-Prime.

Printed
Included with E-Prime shipment, on E-Prime software 
CD, and part of the E-Prime installation (accessed via 
the E-Prime 2.0 menu from the Start menu).

User’s Guide Provides technical details 
about each application. PDF

Included on E-Prime software CD, via the E-Prime 2.0 
menu from the Start menu, and from the PST Product 
Service and Support site.

New Features/
Reference Guide

Fully documents features of 
each application. PDF

Included on E-Prime software CD, via the E-Prime 2.0 
menu from the Start menu, and from the PST Product 
Service and Support site.

E-Basic Help Fully documents all features 
of the E-Basic Language.

Windows 
Help file

Located in the E-Prime 2.0 menu from the Start menu 
or in the Help menu within E-Studio.

Application Help Help for individual 
applications.

Windows 
Help file

Accessed through the Help menu within the 
application.

1.5 Working With E-Prime
Before you begin 
The E-Prime 2.0 Standard and E-Prime 2.0 Professional file extension is .es2. This Getting 
Started Guide uses the .es2 extension for all examples. Please note if you are using E-Prime 
2.0 Professional, you will be prompted to convert your .es2 files to E-Prime 2.0 Professional 
upon opening them. This is because the samples and tutorials are distributed in the E-Prime 2.0 
Standard format. We recommend that you convert your experiments to E-Prime 2.0 Professional if 
you have it. Please note, there may be some differences between the illustrations and what you are 
seeing on your screen. This is because all of the illustrations in the Getting Started Guide are taken 
from the Professional version using a non-converted, Standard .es2 file.

Upgrading your Experiment
We have added several new features to E-Prime 2.0 and because of this there will be some 
differences in experiment settings. We have compiled a list of features that will be affected.
Please see the following link for more details: http://www.pstnet.com/support/kb.asp?TopicID=4756.
If you are currently working in an older version of E-Prime 1.x or 2.0, you will also be prompted to 
convert your experiments when you open them. Once your experiments are converted you will no 
longer be able to open them in older versions of E-Prime. However, when you open your new .es2 
file, a uniquely named backup <ExperimentName>Backup<#>.es2 (.es) of your old experiment is 
automatically created in the folder you are working in. 

Create your First Experiment 
Use one of the sample experiments as a foundation from which to build your first experiment, or 
start from scratch, using the drag-and-drop method in E-Studio. Since this is your first E-Prime 
experiment, it is important to keep it simple (e.g., only two conditions, four stimuli). Once you have 
the simple version of the experiment running properly, you can add to it and make it more complex 
(estimated time to complete: 20-90 minutes for simple experiments). For additional assistance, it is 
recommended that you read Chapter 2 - Using E-Studio in the E-Prime User’s Guide.

NOTE: Getting Started Guide, User’s Guide, New Features/Reference Guide are also all available 
through the Help > Documentation menu in E-Studio.
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Reporting Problems
The PST Product Service and Support site, which can be found at http://www.pstnet.com/support, 
provides the latest updates, a Knowledge Base section, samples, downloads, and a personal 
support interface to communicate with PST support representatives. When reporting problems, it is 
essential that you minimally report the following information:
•   User Information including name, institution, serial number, phone number, and e-mail
    address.
•   Machine Information including Windows version, manufacturer/model of your PC, type of CPU,
    amount of memory, etc. This information is available via the System properties from the
    Control Panel, or by typing msinfo32 into a command prompt.
•   Information about the problem including the name of the application in which the problem
    occurred (E-Studio, E-Run, etc.), version number of the application, and the text of any error
    messages you receive. If applicable, please attach a copy of your .es2 file as well as any 
    additional files (images, sounds, etc.) that are used in the experiment. 

To ensure a timely response, please include all of the information you wish to convey in one post, 
instead of several posts. A common cause for delay in support is due to the end user omitting the 
.es2 file and/or associated files with their request.

The PST User Forum, found at http://www.pstnet.com/forum, is a free service provided by PST for 
end users to share information with each other about any of PST’s products, including E-Prime. 
We encourage you to participate in the PST User forum as a means to share information about 
E-Prime and obtain assistance from a growing and experienced group of E-Prime users.

Useful Information
How to terminate an experiment early
Press Ctrl+Alt+Shift to terminate the E-Run program. Click OK in the dialog box verifying whether 
the experiment should be terminated. Click OK in the dialog box displaying the “Experiment 
Terminated by User” message. Please note that this feature is used to assist with faster testing 
or debugging of an experiment. When an experiment is terminated early using this method, an 
incomplete data file is written, and must be recovered with the E-Recovery application.

Conditional Exit (E-Prime 2.0 Professional only)
Press Ctrl+Alt+Backspace to terminate the E-Run program. Unlike the Ctrl+Alt+Shift termination 
method, this method of terminating an experiment will produce a data file after termination.

Your Serial Number
Your serial number is provided on the Registration Card included with your system. Place the card 
in an appropriate place so that it is accessible. Additionally, your serial number can be found in the 
About E-Studio dialog box via the Help menu within E-Studio (after installation). 
NOTE: DO NOT LOSE THIS INFORMATION. You MUST provide your serial number for Product 
Service and Support.
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Chapter 2: E-Studio
This guide serves as a tutorial to build your first E-Prime experiment. The purpose of this exercise 
is to familiarize you with some of the primary features of E-Studio. 

The experiment used in the E-Prime Getting Started Guide is a variation of the 1996 Blair & Banaji 
study examining automatic and controlled processes in stereotype priming. Blair & Banaji’s results 
support the proposal that stereotypes may be automatically activated, but that these effects may be 
controlled, or even eliminated by the people perceiving the sterotypes.1 

In the experiment described in the following tutorial, participants will be presented with a prime 
word for a short duration. The prime word will be either stereotypically masculine or feminine (e.g., 
sports or flowers) and will have either a positive or negative connotation (e.g., sports or bald). The 
prime will be replaced by a fixation (+), and then a target word will be presented. The target word 
will be either a male or female name (e.g., Bob or Linda). The task is to respond to the target word 
by pressing ‘1’ if the target word is a male name or by pressing ‘2’ if the target word is a female 
name. Reaction time and accuracy will be measured.

The following is an outline of steps you should take to build your first experiment. It is highly 
recommended that you proceed through the entire Getting Started Guide in order to learn E-Studio. 
The purpose of the information on this page is to familiarize you with some terms and schemes 
used throughout this tutorial.

Set up and run the trials.

1 Blair, I. V., & Banaji, M. (1996). Automatic and controlled processes in stereotype priming. Journal of Personality and Social 
Psychology, 70, 1142-1163
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  Click or double click on this object

  Drag the object by holding the left mouse button and moving the mouse to 
the area indicated in the instructions.

Double click Press the left mouse button twice in quick succession.
Right click Press and release the right mouse button.

Drag Press the left mouse button and hold it as you move the mouse to drag the 
object to a new location on the screen.

Drop After a drag action as described above, release the left mouse button to 
place the object in its new location.

Resize window

To resize a window, position the mouse over the edge until the cursor 
changes to a double-pointed arrow, then drag the window to the desired 
size. As an alternative, you can use the Window menu (in E-Studio) for quick 
standardized arrangements.

Select/Highlight Click on the object once or until it is highlighted (i.e., reverse image).
Tab Press the ‘Tab’ key on the keyboard.

You are also strongly encouraged to use the figures throughout this document as visual guides. 
In the figures, you will see various lines and arrows to point out specific areas of interest. Use 
the table below to interpret the arrows, lines, and terminology.

Finding the “My Experiments” Folder
E-Prime 2.0 is compatible with Microsoft Windows XP, Vista, and Windows 7. You will frequently 
be working within the “My Experiments” folder, because this folder is the default location to 
store new experiments created with E-Studio. E-Prime creates the “My Experiments” folder 
in your personal documents folder on your PC. This folder also contains the “Samples” folder, 
which stores the sample experiments that are documented in Appendix B of the E-Prime 
User’s Guide, and the “Tutorials” folder, which stores the E-Studio files that are documented in 
the E-Prime Getting Started Guide. 

The table below shows the default paths to your personal documents folder. Note that the path 
on your particular machine may have been modified by your administrator:

Operating 
System Path to your personal documents folder(“My Documents” or “Documents”)

XP <drive>\Documents and Settings\<user name>\My Documents\
Vista <drive>\Users\<user name>\Documents\
Windows 7 <drive>\Users\<user name>\My Documents

When the E-Prime documentation directs you to the “My Experiments” folder, it does not 
include the full path to the folder. Instead, the documentation refers to “...My Experiments”, 
where the “…” indicates the full path up to your personal documents folder. When you see this 
notation in the documentation, replace the “…” with the path to your personal documents folder. 
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Open the E-Studio application and begin creating a new experiment.

Task 1: Start the E-Studio application and name the experiment

1)  Click on the Windows Start menu,
     select All Programs, and then
     select E-Prime 2.0. From the 
     menu, click on E-Studio to launch 
     the application.
        This will launch the E-Studio
        application.

2)  Select the Blank (Standard)
	   option and click OK.
        If you are using E-Prime 2.0 
        Standard you will not need to do 
        this step.

 1

 2 
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This task will introduce you to some of the major components and features of the E-Studio interface. Located 
to the far left of the interface, the Toolbox contains the E-Objects which you will use to create your experiment. 
The objects can be added to the experiment by dragging and dropping them onto the Structure window. The 
Structure window shows the layout of your experiment and works similarly to a Windows Explorer folder. When 
you highlight an object in the Structure window, information about the object will be displayed in the Properties 
window. Note that you may resize the windows to reveal more of the Workspace.

Task 2: Preview the E-Studio interface

3 

 

1
 

2

 

4

1)  Locate the Toolbox, which 
     contains objects that are dragged to
     procedural timelines. The objects
     are the basic building blocks of your
     E-Studio experiments.
        In E-Prime 2.0 Professional, you 
        can right click in the Toolbox to 
        change the Toolbox defaults.

2)  Locate the Structure window,
     which contains a hierarchical
     representation of your experiment.
		  This window features a tree view
 		  similar to that in Windows
		  Explorer.

3)  Locate the Properties window,
     which contains the list of associated
     properties for each object.
		  Each object has a set of 
		  associated properties that are 
        displayed in the Properties 
        window when the object is 
        highlighted.

4)  Locate the Workspace, which
     contains the window 
     representations of the various
     objects.
		  You can open a window 
		  representation of an object by
		  double clicking on it in the
		  Structure window.
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There are several different types of E-Objects that can be used to display information during an experiment. 
The most basic of these objects is the TextDisplay. The TextDisplay is used to present text to the experiment 
participant. In order to add a TextDisplay to your experiment, locate the TextDisplay in the Toolbox and drag 
and drop the object onto the SessionProc. All of the properties related to this object will be explained in detail.

Task 3: Create your first object

1)  Double click the SessionProc
     object in the Structure window.
        SessionProc is a Procedure
        object automatically created in
        each new Experiment 
        Specification (.es2) file.
        Double clicking an object will
        open a window version of the
        object in the Workspace. You
        can resize the various windows
        to fit in the Workspace.

2)  Click and drag the TextDisplay
     object from the Toolbox, and
     drop it on the beginning of the
     SessionProc timeline.
		  This is also reflected in the 
		  Structure window. Notice
		  changes in the Structure
		  window as this tutorial continues.

3)  Highlight the newly placed
     TextDisplay object (by clicking on
	   it) to view its properties in the
     Properties window.
		  Highlight the object in either the 
		  Structure window or on the
		  SessionProc. Every object has a 
		  set of associated properties which 
		  are displayed in the Properties 
		  window when the object is 
		  selected.

 

3
 

1

2

 

3
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Now that the TextDisplay has been added to the experiment, it needs to be altered to perform the desired 
function. This TextDisplay will be used to present the instructions to the participant. First we will rename the 
TextDisplay to Instructions. This can be done several ways. The steps below will illustrate how to change the 
TextDisplay name using the Properties window.

Task 4: Name the TextDisplay object

2 1 

1)  In the Properties window, locate
     the (Name) property.
        The highlighted object’s
        associated properties are
        listed in alphabetical order.
        However, the most frequently
        used properties are located
        at the top of the list.

2)  Click in the box to the right of
     (Name) and change the value from
     TextDisplay1 to Instructions.
     Press the Enter key to accept the
     new name.
        Notice that the object’s name has
        changed in both the Structure
        window and in the SessionProc
        timeline. These displays are
        updated when you press Enter. 
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1)  From the File menu, select the
     Save As... command (or press
     F12). In the My Experiments folder,
     name the file Tutorial. Click the
     Save button to dismiss the dialog.                  
        Experiment Specification files
        receive an .es2 extension. 
	     When working in E-Prime 2.0 
        Professional, the default Save As 
        type is E-Studio 2.0 Professional 
        Files (*.es2), unless the 
        experiment originated in the 
        E-Prime 2.0 Standard format.

2)  Double click the object named
     Instructions either in the
     Structure window or the
     SessionProc timeline.
        This will open a window 
        representation of the TextDisplay 
        object named Instructions. 

3)  Click on the Property Pages
     button in the upper left corner of the
     Instructions window.
        This will open a set of tabbed
        pages called Property Pages,
        which will allow you to specify the 
        object’s properties.

 2

 1

3 

 1

Next, we will save our work using the File menu > Save option from within E-Studio. Once the Save option 
has been selected, E-Prime 2.0 will prompt you for a filename. You are able to choose any name you wish. 
However, we recommend calling the experiment ‘Tutorial.’ This will aid you in finding where you left off later, 
if you are not able to complete the entire tutorial in one sitting. 
      NOTE: It is also possible to save by using the Ctrl+S key combination at any point during experiment
      creation.

Task 5: Save the experiment and view the Property Pages
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Now we will edit the Text property of the Instructions to explain the experimental task to the participant. This 
property is located on the General tab of the Property Pages. The visual appearance of the Instructions can 
also be altered using the other properties located on the General tab, but for our purposes we will use the 
default settings. Once we have entered the Instruction text into the Text property, we will set the Duration of 
the Instructions to be infinite. This will force the Instructions screen to stay on screen until an event occurs to 
terminate it. 

Task 6: Specify the object properties

1)  On the General tab of the
     Properties dialog, locate the
     Text field and type: 
     “Welcome to the experiment.
      <Enter> You will see a priming
     word followed by a fixation.
     <Enter> A target word will follow
     the fixation. <Enter><Enter> Your
     task is to determine if the target
     word was a male or female name.
     <Enter><Enter> Press the “1” key
     for a male name and the “2” key
     for a female name. <Enter><Enter>
     PRESS THE SPACEBAR TO
     BEGIN!”
        This will be the text displayed to 
        the participant.

2)  Click on the Duration/Input tab.
     Specify the Duration of the display
     to be (infinite).
        The (infinite) setting results in the
        object running until some
        condition is met (e.g., a keypress). 2

1   
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Only the keyboard and mouse are enabled as possible input devices by default. If you have an external device 
with which you want to collect a response (e.g., joystick) you will need to add it to the list of input devices at the 
experiment level before you can enable it on the Duration/Input tab. To add an input device at the experiment 
level, double click the Experiment Object at the top of the Structure window and select the Devices tab from the 
Property Pages. Click the Add button to see a list of devices you can add to your experiment. Once you have 
selected and added the new device, you can then enable it as an input device on the Duration/Input tab of any 
object collecting a response. For more information on adding an input device at the experiment level, please 
refer to the Duration/Input topic in the E-Prime Reference Guide.

Task 7: Enable the keyboard as an input device

1)  On the Duration/Input tab, click
     the Add button under the Device(s)
     window.
        The Add Input Device dialog will
        be displayed.

2)  Click the Keyboard device to
     select it, and click OK.
        The keyboard will now be enabled
        as an input device, and the
        Response Options fields will
        become available.

        

  2

 1
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We have set up the Instructions object to accept input from a keyboard. Now we will choose the particular input 
that the Instructions object will act on and what that action will be. In this instance, we will use the space bar to 
end the Instructions display.

Task 8: Set the response options for the keyboard device

1)  Select the Duration/Input tab and 
     edit Allowable to read {SPACE}.   
        Only those keys specified in the 
        Allowable field will be considered 
        valid responses. All other keys will 
        be ignored. 
        NOTE: The Braces, {}, and all
        capital letters tell E-Prime that the
        word “SPACE” refers to a special
        character. See E-Basic Help,
        {key} naming scheme for more
        information. 
        
2)  Verify the EndAction field reads
     Terminate. 

3)  On the Frame tab edit the Width 
     and Height to 100%. Click OK to 
     exit the Property Pages.

4)  Close the Instructions object in 
     the Workspace.

 1

 2

3  

3  
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Next we will add another TextDisplay. This TextDisplay will notify the participant that the experiment has 
concluded. Start by dragging and dropping another TextDisplay from the Toolbox onto the SessionProc. You 
can rename the object via the same method as last time, or highlight the TextDisplay, press F2 to edit, type the 
new name, and press Enter to accept the new name.

Task 9: Create and Edit the Goodbye object

1)  Drag a new TextDisplay from 
     the Toolbox and drop it after 
     the Instructions object in the 
     SessionProc procedure. The 
     object will be given a default name 
     of TextDisplay1. 
       
2)  Click on the TextDisplay1 to select 
     it then press F2 to rename the 
     object.
        You may alternatively right click 
        on the object and select Rename 
        from the context menu.

3)  Type “Goodbye” as the new 
     object name, and press Enter to 
     accept the change.

4)  Double click the Goodbye 
     object to open the object in the 
     Workspace.

5)  Type “Thank you and Goodbye.” 
     directly into the Goodbye object.
        This will be the text displayed to  
        the participant.

 1
 2

 5

 4

3
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6)  Open the Goodbye object’s 
     Property Pages.

7)  On the Duration/Input tab, specify
     the Duration of the display to be
     5000ms. Do not add an Input 
     Device.
        All durations in E-Studio need to 
        be specified in milliseconds. 
        Do not include the units (ms) when 
        specifying durations as it will 
        cause an error.

8)  Click OK to dismiss the Goodbye 
     object Property Pages.

9)  Close the Goodbye object in the
     Workspace.
        Click the     in the upper right 
        corner of each window, or choose 
        Close All from the Window menu.       

The Goodbye object is open and ready to be configured. We will edit the Goodbye object’s properties so that it 
will display the dismissal text to the participant for five seconds before the experiment concludes. No responses 
will be registered by the Goodbye object. Instead, the display will terminate when the specified duration has 
expired. 

Task 9 (continued): Create and Edit the Goodbye object

 6

 7

 8
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Try to think of your experiment in layers. The top layer is the SessionProc object. It works like a receptionist 
to control all of the greetings and administrative events in the experiment, such as the instructions and the 
goodbye screen at the end of the experiment. The next layer we add will act like a manager, because it will 
oversee all of the experimental tasks that are presented to the participant. In order to create this layer, we will 
begin by adding a List object to the SessionProc. The List object can be used to present different stimuli at the 
same point in the experiment. We will create the list to run a block of trials.

Task 10: Create the BlockList object

 3

 

 1

 2

1)  Locate the List object in the 
     Toolbox. Drag it to the
     SessionProc and drop it between 
     the Instructions and Goodbye 
     objects. Use F2 to rename it to 
     BlockList. 
        After you rename the List, you
        will be able to view its properties
        in the Properties window.
       
2)  Double click the BlockList object.
        This opens the BlockList object’s
        window in the Workspace.
        Remember to resize the windows
        in the Workspace to maximize
        your view.

3)  Now is a good time to save your
     experiment. To do this, press
     Ctrl+S, select Save in the File
     menu, or click the Save icon on the
     Application Toolbar.
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1)  Click the Add Attribute tool button
     in the BlockList object.
        This will open a dialog box, which
        allows specific properties of an
        Attribute in the List object to be
        set.
       
2)  Type “PracticeMode” in the Name
     field and click Add.
        This will create a new Attribute
        called PracticeMode. The Default
        Value is used to automatically   
        enter a value when the new levels 
        are added.
        NOTE: Spaces are not permitted
        in Attribute names. An Attribute
        name can contain only letters,
        numbers, the underscore (_), and
        the period(.). The first character 
        must be a letter.

3)  Type “no” in the first cell of the
     column labeled PracticeMode.
        This will specify that the value of
        the Attribute PracticeMode is
        equal to “no,” identifying the block
        of trials as non-practice. 

Task 11: Define the BlockList object
Now that we have created the BlockList object, we must set it up to manage the experiment. When you start 
running participants for your study you may want to set up an experiment that allows your participants to 
practice the task before they perform the actual experimental task. We will want to distinguish the practice task 
from the actual experimental task. To accomplish this we will need to create an Attribute within the BlockList 
called PracticeMode. 
      NOTE: Any Attributes that you define on List objects will automatically be logged to your data file when the
      experiment is run. 

3

 

 1

 2
 2



25

E-Prime 2.0 Getting Started Guide 

1 

  2
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The next thing we will do is complete the “management” layer that we started with the BlockList. This will 
require making a new Procedure called the BlockProc.

Task 12: Create and define the Block Procedure

1)  In the first cell of the Procedure 
     column of the BlockList, type 
     “BlockProc” and press Enter. 
       
2)  A dialog will indicate that the 
     BlockProc procedure does 
     not exist. Click Yes to create the 
     Procedure object BlockProc.
        Notice the BlockProc procedure
        has been created in the Structure
        window.

3)  Click No when you are prompted to 
     make the BlockProc Procedure 
     the default value for newly created 
     levels. 
        It is likely that the Procedure will 
        change at the block level.

4)  Close the SessionProc and
     BlockList windows in the
     Workspace.
        Click the     in the upper right 
        corner of each window, or choose 
        Close All from the Window menu.

5)  Press Ctrl+S or click Save in the 
     File menu to save your experiment.

6)  Click the Generate button to
     compile the experiment script as
     specified thus far.
        It is a good practice to generate
        your script after completing        
        individual parts of an experiment
        in order to catch potential errors.
        If errors are found, the Output 
        window will open at the bottom of 
        the screen to display the errors. 
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For a functional experiment, stimuli must be presented to the participant. In order to do this we need to add 
another layer to the experiment. This layer does all of the work in regard to stimulus presentation. Here the List 
object Attributes often equate to the factors, conditions, or independent variables that are important to your 
design. Remember, all Attributes created are automatically logged to your data file when the experiment is run. 
To create the “worker layer”, we will begin by adding a List object to the BlockProc.

Task 13: Create and define the TrialList object

1)  Double click the BlockProc object 
     in the Structure window to open it
     in the Workspace.
       
2)  Drag a new List object to the
     BlockProc timeline and use F2 to
     rename it TrialList.
        TrialList will be used to organize
        your trial-level Attributes/variables
        and their values.

3)  Double click the TrialList on the 
     BlockProc timeline. 
        This will open the TrialList 
        spreadsheet-like window in the
        Workspace. Resize the window as
        needed.

4)  Click the Add Attribute tool button
     on the top of the TrialList window.
        This will open the Add Attribute
        dialog box. 

5)  Specify the Name of the Attribute
     to be PrimeGender and the
     Default Value to be female. Click 
     Add when you are finished.
        The name of your first Attribute
        is PrimeGender. The priming word
        displayed will be male or female. 
        Thus, this column will eventually 
        be filled with values of either 
        ‘male’ or ‘female’ (the levels 
        of this Attribute). The Default 
        Value is useful in saving typing 
        time. By specifying ‘female’ as 
        the Default Value, all of the cells 
        in the PrimeGender column will 
        initially have the value of ‘female’ 
        when a new level (row) of the list 
        is created.

 4
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Next we will add the Attributes necessary to present your stimuli.

Task 14: Specify Attributes in the TrialList
 

 

 

 

2

 
 

 

2

 1

 2

1)  Click the Add Multiple Attributes
     tool button. In the Add Multiple
     Attributes dialog, type 5 and click
     OK.
        Five new Attributes, Attribute1 -
        Attribute5, will be added to the
        TrialList.
       
2)  Double click on the column
     headings for Attribute1 - 
     Attribute5 to change the 
     attribute names and specify 
     default values using the table
     below.

        
        When you are finished, your 
        TrialList object should look similar
        to the one shown to the right.
        NOTE: The defaults will not show 
        up in the list until you add more 
        levels to the TrialList object.

Attribute Name Default Value

PrimeType positive

NameGender female

CorrectAnswer 1

Prime ?

Target Linda

 1
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Now we will complete the “worker” layer of the experiment. First we will add the Trial Procedure, and then we 
add levels to the experiment. 

Task 15: Specify levels in the TrialList and create the Trial 
Procedure

1)  Select the first Procedure cell 
     on the TrialList, type TrialProc, 
     and press Enter.
       
2)  Click Yes to create the TrialProc.

3)  Click Yes to make the TrialProc 
     the default value for newly created 
     levels.

4)  Click the Add Multiple Levels tool 
     button and enter 7 to add seven
     levels. Click OK to add levels.

5)  Compare your TrialList to the 
     TrialList shown.

 1

 2

 3
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Now we will specify what stimuli we want presented at each level of the Trial Procedure. 

Task 15 (continued): Specify levels in the TrialList and create 
the Trial Procedure

 

7

 

7

66)  Using the table below, complete 
     the TrialList object grid to match 
     the one shown to the right. 

        
        The List object fills in information 
        using auto complete, e.g., after  
        you enter “male” as a new value 
        for PrimeGender, when you type 
        “m” in the next cell the List will fill 
        in “male.” 

7)  Save and generate the
     experiment. 

Name Value

Procedure TrialProc

PrimeGender 4 male, then 4 female

PrimeType alternate 2 positive, then 
2 negative

NameGender alternate male, then 
female

CorrectAnswer alternate 1, then 2

Prime 2 sports, 2 bald, 
2 flowers, 2 laundry

Target alternate Bob, then Linda
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Like all objects in E-Studio, the List object has properties. The List object features a variety of properties 
related to condition selection (how the rows of information are ordered and selected), and these properties are 
located in a set of Property Pages. This task will guide you through the specification of those properties.

Task 16: Specify the TrialList object properties

1)  Click the Property Pages button in 
     the TrialList window.
        A set of tabbed Property Pages is
        opened. Here, you will specify the
        condition selection options.

2)  Click on the Selection tab and set
     the Order of selection to Random
     from the dropdown box. 
        The Random ordering option is
        random without replacement.

3)  Select the Reset/Exit Tab and
     verify that the option to reset after
     “All samples (8)” is selected. 
        The levels of the List will be
        replaced and reshuffled after all 8 
        levels have been shown as 
        stimuli.

4)  Verify the option to exit after
     “After 1 cycles (8) samples” is
     selected. Click OK. 
        The List will run for one cycle of 8
        samples and then exit.
  
5)  Review the TrialList Summary 
     and close the window. 
        Notice that the summary is
        reflected on the List object, and
        may be shown or hidden using
        the Summary toggle button.

6)  Press Ctrl+S to save your 
     experiment.

 1
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1)  Double click the TrialProc object
     in the Structure window.

2)  Drag a TextDisplay object from the
     Toolbox to the TrialProc. Rename
     this object “Prime.”

3)  Drag another TextDisplay object
     from the Toolbox and to the
     TrialProc. Rename this object 
     “Fixation.”
        You can also rename objects
        from a context menu. Access the
        Context Menu by right clicking the
        object.

4)  Drag a Slide object from the
     Toolbox to the TrialProc.
     Rename this object “Target.”
        A Slide object allows presentation
        of text, sound, images, and 
        movies concurrently.

5)  Drag a FeedbackDisplay object
     from the Toolbox to the TrialProc.
     Rename this object “Feedback.”
        Feedback is the last event of the 
        trial procedure.

Now that we have completed the “worker” layer of the experiment, we need to define what work is to be 
performed, i.e., what constitutes a single trial. We will set up a procedure named TrialProc to do this. In this 
experiment, a single trial consists of four events: the Prime, a Fixation display, the Target (when the critical 
stimulus is presented and the response is collected from the participant), and Feedback based on the 
participant’s response. 

Task 17: Define the TrialProc

 2 
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Next we will define the properties of the Prime object. We will use the Prime Attribute from the TrialList object 
to dictate what is displayed by the Prime object. This is achieved by enclosing the desired Attribute in square 
brackets, e.g., [Prime]. We will not need to add an input device because the Prime object will not collect 
responses.

Task 18: Specify the properties for Prime object

1)  Double click the Prime object to
     open it in the Workspace.

2)  Click the Properties button to 
     open the Prime object’s 
     Property Pages. 

3)  Select the General tab. In the Text 
     field type: [Prime] to indicate that
     the text to be displayed will vary
     according to the Prime Attribute,
     which was created earlier in the
     TrialList.

4)  On the General tab, notice
     that the Prime text will be centered
     by default. (AlignHorizontal and
     AlignVertical are set to center).

5)  Select the Frame tab, specify the 
     Width and Height to be 100%.

6)  Select the Duration/Input tab, 
     specify the Duration to be 
     1000ms. 

7)  Click OK to close the Property 
     Pages window. 

 5

 6

 7

 3

 4

 1

2

 



33

E-Prime 2.0 Getting Started Guide 

We will now define the properties of the Fixation object using the Property Pages. The Fixation object will 
display a ‘+’, and like the Prime object it will not collect responses.

Task 19: Specify the properties for the Fixation object

1)  Double click the Fixation object to
     open it in the Workspace.

2)  Click the Properties button to 
     open the Fixation object’s 
     Property Pages. 

3)  On the General tab of the Property
     Pages, specify the Text to be a ‘+’
     and the AlignVertical and 
     AlignHorizontal properties to be
     set to center (default).

4)  On the Duration/Input tab, set the
     Duration to be 1000ms.

5)  Click OK to accept the settings.

6)  Close the Fixation window, and
     Press Ctrl+S to save the
     experiment.

 6
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Slide objects are used to present text, sound, images, and movies concurrently. Sub-objects define the type 
and location of the stimuli composing the Slide. This step will add a text sub-object to the Slide object so that 
the Target can present text stimuli using the Target Attribute from the TrialList object.

Task 20: Add text to the Target object

1)  Double click the Target object to 
     open it in the Workspace.
       
2)  Click the SlideText button on the
     Slide toolbar, then click anywhere
     within the active Slide window.
        A text sub-object will appear in
        the Slide window.

3)  Use the dropdown menu on the
     Slide toolbar to select the text
     sub-object. Then click the green
     sub-object Property Pages
     button on the Slide toolbar.
        There may be many sub-objects
        composing a Slide. Select the
        desired sub-object to set the
        appropriate properties.

4)  On the General tab, enter [Target]
     in the Text field to indicate that the
     text to be displayed will vary
     according to the Target Attribute,
     which was created earlier in the
     TrialList.

5)  On the Frame tab for the text sub-
     object, set the X- and Y- Position
     properties to center.
        This will center the text in the
        display.

6)  Click OK to accept the settings.

 4
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Now we will set a duration for the Target object, enable a participant response, and set the Correct field to use 
the CorrectAnswer Attribute to score responses.

Task 21: Set Target Duration and Enable Input

1)  Click on the Target object in the
     Structure window. Next, in the
     Properties window, click in the
     Duration field and then on the
     ellipsis that appears in the field.
        This is another way to display the
        Property Pages for the Target
        object.
       
 
2)  On the Duration/Input tab, set the
     Duration to 10000ms.

3)  Set the Data Logging to Standard.

4)  Click Add and double click the 
     Keyboard to add it as an Input 
     Device. 

5)  Specify the Allowable fields to be
     “1” and “2.” 
        This notation means that either              
        1 or 2 will be accepted, not the 
        literal number 12.

6)  Set the Correct field to 
     [CorrectAnswer]. Verify the Time
     Limit is set to (until feedback), and
     the EndAction is set to Terminate. 
     Click OK. 
        If you wish to change the criteria 
        for CorrectAnswer you must do 
        so in the TrialList, and adjust 
        Allowable in the object Properties.

 6
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Next, we will link the Feedback object with the input collected by the Target object. This should not be confused 
with the Attribute named Target, which will be specified as: [Target]. The Feedback object will present the 
appropriate feedback on each trial based on how and when the participant responded to the stimulus displayed 
by the Target object.

Task 22: Link the Feedback object to the input object

1)  Double click the Feedback object
     to open it in the Workspace.
       
2)  Click the white Property Pages 
     button to view the Property Pages 
     of the Feedback object.

3)  On the General tab, specify the
     Input Object Name to be Target.
        You need to specify the name of
        the object that is collecting the
        participant’s response. In this
        experiment, the participant’s
        response is collected in the Slide
        object named Target.

4)  Click OK when you are finished, 
     and press Ctrl+S to save the
     experiment.
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The Feedback object is a Slide object that has been configured to present information to the experiment 
participant regarding their performance during the experiment. There are four SlideStates that are included by 
default: Correct, Incorrect, NoResponse, and Pending. Each SlideState defines a different type of feedback for 
each type of possible response. Statistics, such as response time or average percent correct, can be included 
on the Feedback SlideStates by using macros. For more information on the available macros (indicated by the 
@ symbol), refer to the FeedbackDisplay topic in the E-Prime Reference Guide. 

Task 23: Specify the properties for the Feedback object

1)  Click each of the tabs at the
     bottom of the Slide to view the
     various SlideStates included in the
     Feedback object.
        SlideText sub-objects on the
        SlideState use FeedbackDisplay
        macros to display the reaction
        time, accuracy, etc.
       
2)  On the “Correct” SlideState, click 
     the text box containing the 
     “Correct!” message. Then click 
     the green Sub-Object Property 
     Pages button.

3)  On the General tab, set the Text
     field to read “Good Job!” and the
     AlignHorizontal field to “center.”

4)  Click the Frame tab and set the
     BorderWidth to “10” to create a
     thick border around this text.

5)  When finished, click OK to
     dismiss the Property Pages.

6)  Close the Feedback object, and 
     press Ctrl+S to save.

 2
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We have finally finished configuring the experiment. One of the last things left to do is to generate the script 
to check for errors. E-Prime has an Output window which allows you to view any errors that occur during 
script generation. These errors are called compile or script generation errors. When an error occurs, E-Prime 
prompts you with a message box, the Output window will display the error including the line of script in which 
the error was found. This will allow you to locate the place in the script where the error occurred so that it can 
be fixed. 

Task 24: Generate the Script

1)  Click the View menu, and select 
     the Script and Output windows.
        NOTE: You must select each
        window individually. When a
        window is currently in view on the
        workspace, there is a checkmark
        next to it in the View menu.

2)  Click the Generate button and 
     notice the Output window in the 
     lower left corner of the interface. 
     When you generate the script, 
     E-Studio provides a progress 
     report in the Output window. 
        If you have converted your
        experiment to E-Prime 2.0 
        Professional, you will also see
        an Advisor tab within the Output
        window. For more information 
        on Experiment Advisor, please 
        refer to the New Features/ 
        Reference Guide. 

3)  In the Script window, you can see
     the script that E-Studio generates
     for you. You could have spent days
     or weeks writing all that script, but
     with E-Studio, you did it much more 
     quickly.

 2
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The second to last step you need to do is run your experiment to check for run time errors. Run time errors 
are the errors that occur when your experiment is running. Like compile errors, E-Prime prompts you with a 
message box, and the Output window displays the error and the line of script in which the error was found. This 
will allow you to locate the place in the script where the error occurred so that it can be fixed. Because run time 
errors, such as a failure to find an external stimulus file, can only be detected during the experimental run, it is 
paramount to test your experiment. The last step when developing an experiment is to look at your data. This 
way you can confirm that you are logging everything necessary for your analysis, double check your timing, 
and make any necessary corrections before you begin running actual experiment participants. Chapter 4 of the 
this manual explains how to do this with E-Prime’s data analysis program, E-DataAid. 

Task 25: Run your experiment

1)  Review your experiment 
     structure.
        Compare the structure of your 
        experiment to the diagram 
        included at the beginning of this
        tutorial to see how the original 
        experimental design is 
        implemented in E-Studio.
      
2)  Click the Run tool button.
        If the experiment script is
        generated successfully, the
        E-Run application launches and 
        executes the E-Basic script 
        (.ebs2) file. If errors are 
        generated, refer to Chapter 7:
        Troubleshooting in this manual for
        additional information.

3)  At the beginning of each run,
     several participant initialization and
     startup dialogs are presented in
     order to collect participant 
     information. Click OK in each 
     dialog to accept the default 
     settings and begin the experiment!

 1
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Task 25 (continued): Run your experiment
Let’s review what you can expect to see when the experiment runs. First, you will see the instructions. Once 
you have read and understand the instructions, press the spacebar to begin the experiment. Next, the priming 
word is presented. This is followed by a fixation. 

4

5

6

4)  Read the experiment Instructions,
     then press the spacebar to 
     continue.
      
5)  Read the Prime object text.

6)  Wait the duration of the fixation
     until the Target is presented.
        NOTE: The fixation for this
        experiment is a plus sign.
 



41

E-Prime 2.0 Getting Started Guide 

Next, the Target stimulus is shown and you will then make your response. Your response will be subsequently 
scored as correct, incorrect or no response, and will be accompanied by reaction time information. The 
experiment will run for eight trials. After the last trial, you will be presented with the Goodbye message, 
indicating the experiment is over.

Task 25 (continued): Run your experiment

7)  Read the Target object text and
     respond.

8)  Read the Feedback object text.
     Repeat steps 5-8 for all eight 
     trials.

9)  Read the Goodbye object text.

10) Congratulations, you have
     completed the first tutorial. After the
     experiment has finished running
     you may save your experiment
     and close E-Studio.

7

8

9
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1)  Click on the Windows Start menu,
     select All Programs, and then
     select E-Prime 2.0. From the
     menu, click on E-Merge to launch
     the application.
        A Quick Reference dialog is
        displayed, detailing the basic
        steps necessary to merge files.

2)  Click Close to dismiss the Quick
     Reference dialog.
        The Quick Reference is presented
        as a reminder of the merge
        process. The Quick Reference
        dialog can be displayed at any
        time using the View menu.

2 

2 

 1

Chapter 3: E-Merge

When you run an experiment (.es2 file) E-Run collects all data as individual participant data files (.edat2 files); 
there is a separate .edat2 file for each participant. The E-Merge application is used to merge single participant 
data files into a master file for analysis. We begin by opening the E-Merge application.
      NOTE: From within the E-Studio application you can also select Tools > E-Merge to open E-Merge.

Task 1: Open E-Merge
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The Folder Tree window on the left side of the E-Merge display allows you to navigate to the folder containing 
your data files. E-Merge is typically used after collection of multiple participant data files.

Task 2: Locate your experiment files

1)  In the Folder Tree, navigate to the
     ...My Experiments\Tutorials\Data 
     folder.

2)  After selecting a folder in the
     Folder Tree, the File List window
     (on the right side of the display) 
     displays the available data files in 
     that folder.
        There are five participant data
        files located in the folder named
        Data. These files have been
        collected by five participants
        running the experiment you
        created in the previous tutorial.

 1

 2
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Now that you have located the files, you will select the unmerged files and merge them into one master file. 
Then you must choose what type of merge operation you wish to perform. Use the Standard Merge operation 
when files are located within a single folder. Use the Recursive Merge option when data files are located within 
sub-folders.

Task 3: Select files to merge and choose a merge operation

1)  Click the Select Unmerged tool
     button to select all E-Prime data
     files (*.edat or *.edat2) that have 
     not yet been merged into another 
     file.
        A single data file can be selected 
        by clicking on its filename. 
        Multiple data files can be selected 
        one at a time by clicking on each 
        filename while keeping the Ctrl 
        button held down. 

2)  Click the Merge tool button on the
     toolbar.

3)  A dialog appears requesting the 
     type of merge operation to 
     perform.  
        Standard Merge is the default  
        operation.

4)  Click Next to continue with a 
     Standard Merge operation.
 

 2
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Now we will designate our target data file, which is the file in which we want to store the merged data. In this 
example, we are creating a new merged data file named ‘Merged Tutorial Data’. It is also possible to merge 
new single participant data files into an existing merged data set by specifying an existing data file as the 
Target File. However, the same data cannot be merged into a file more than once. 

Task 4: Set the Target File

1)  Type Merged Tutorial Data for the 
     File name. This is the Target File. 
     Click OK to launch the merge 
     operation.
        The single session data files
        selected will be merged into this
        target file.

2)  Click Yes to create the Merged 
     Tutorial Data target file. 

3)  Review the Merge Results dialog
     displayed after the merge
     operation is complete.

4)  Click OK to dismiss the Merge
     Results dialog.

1
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Let’s look at the results of the merge. In the File List window, the icon to the left of each filename designates 
the file type, along with the file extension. A green checkmark designates a merged data file, and a red target 
symbol denotes the target file. The E-Merge interface also contains some other useful information about the 
data files. We will examine the interface below before moving on to analyze the data.

Task 5: Examine merge results in the File List

1)  In the File Name column the 
     green checkmark designates that 
     the .edat2 file has been merged  
     into a Target file. 
        The Status column reads Single 
        Session for each of the .edat2 
        files that were collected from an 
        individual participant run. 
        NOTE: If you do not have your 
        Windows folder settings set to 
        display known file extensions, you 
        will not see the .edat2 and .emrg2 
        extensions.

2)  The Target file, 
     Merged Tutorial Data.emrg2, is
     designated with a red target. 
     The Status column value also
     reads TARGET.
        The location of the Target file        
        will also be listed at the bottom of 
        the E-Merge window. 

3)  A merged data file (.emrg2) that is 
     not currently set as the target data 
     file will have its Status listed as
     Merged Data.

4)  The Last Merged column for each 
     of the single subject (.edat2) files 
     lists the date that the file was 
     merged into a merged data file.

5)  The Last Modified column for 
      Merged Tutorial Data.emrg2 lists 
      the date of the merge operation. 
        Notice that merged data files are
        the only files that have been 
        modified.

6)  Congratulations, you have
     completed the E-Merge tutorial.
     You may close the E-Merge
     application at this time. 
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 1

1)  Click on the Windows Start menu,
     select All Programs, and then
     select E-Prime 2.0. From the
     menu, click on E-DataAid to
     launch the application.
        The E-DataAid application 
        launches without opening a 
        specific data file. A file must be
        opened within the application.

Chapter 4: E-DataAid

The E-DataAid application is used to edit or examine your data, perform basic analysis, and prepare it for
export to another application (such as Excel). We begin by opening the E-DataAid application.
      NOTE: From within the E-Studio application you can also select Tools > E-DataAid to open E-DataAid.

Task 1: Open E-DataAid



48

E-Prime 2.0 Getting Started Guide 

In order to perform this task, we need to open the merged data file we created in the last tutorial. If you did not 
complete the last tutorial, you will need to do so now before you can perform this task.
      NOTE: If you accidentally overwrite any data or tutorials, you are able to restore any of the experiments or 
      data files included with the E-Prime installation. In E-Studio, select Tools > Options, select the General Tab.
     Then click Copy Samples and Tutorials to My Experiments Folder...

Task 2: Open a data file

1)  In E-DataAid, click the Open tool
     button, or press Ctrl+O.
        There is also an Admin Open
        command available from the File
        menu, which allows the user to 
        set security options for the data 
        file (see Opening As Administrator
        in the E-DataAid chapter of the
        E-Prime Reference Guide for
        more information). 

2)  Navigate to the 
     ...My Experiments\Tutorials\Data 
     folder. 
        All of the data files in the folder, 
        either single participant (.edat2) or 
        merged (.emrg2), appear in the 
        Name column.

3)  Select the 
     Merged Tutorial Data.emrg2 file
     and click Open.
        The Merged Tutorial Data.emrg2 
        file contains data from the five 
        participants who participated in 
        the Tutorial experiment.

4) This is what an open 
     Merged Tutorial Data.emrg2 
     file looks like.

 2
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It is important to know how to filter the data so you are able to look for missing data and perform different types 
of analyses. We will filter this data set to look at only correct trials. 

Task 3: Filter the data

1)  On the Toolbar, click the Filter tool
     button to display the Filter dialog.
        The Filter command is also
        available through the Tools menu,
        or by right clicking a column
        header.

2)  Select Target.ACC in the Column
     name field.
        Target.ACC contains the
        accuracy data for the participant’s
        response on each trial
        (0=incorrect, 1=correct).

3)  Click the Checklist button and
     click the checkbox next to “1”.
        The Checklist filter displays all 
        unique values contained with a
        variable (in this case 
        Target.ACC), and allows selection
        of individual values for inclusion 
        in the filter. By clicking on the 
        1 box, only those trials in which 
        the participant responded
        correctly will be included in any 
        subsequent data analyses.

4)  Click OK to apply the filter. 

5)  Close the Filter dialog.
        Notice that the Filters window at
        the bottom of the application
        indicates Target.ACC=1 as an
        active filter, and that the 
        Target.ACC column header has
        turned white to indicate that a
        filter is now in place (you may
        need to scroll to the right in the 
        spreadsheet to see this column).
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By default, the E-DataAid spreadsheet displays the ExperimentName, Subject, and Session variables in the 
first three columns. The other variables are arranged alphabetically within levels (e.g., Session, Block, Trial, 
etc.). E-DataAid also has the ability to mark any changes you make to the data files in the event that you need 
to alter your data for housekeeping purposes. For example, let’s suppose a participant ID number was entered 
incorrectly at the time the experiment was run. You can enter the correct value in E-DataAid and the program 
will reflect this alteration by changing the font color for the edited values.

Task 4: Edit cells

 1

 2

 3

1)  Click the first cell in the Subject
     column to select it. Type 11 in the 
     first cell and press Enter.
        After you press Enter, E-DataAid 
        automatically changes all of the 
        cells for the Subject column in this 
        session from 1 to 11.

2)  All modifications are displayed in 
     red. 
        NOTE: E-DataAid tracks and
        annotates all alterations made to
        a data file. See View > Display
        Annotations...

3)  Click the Undo button to return
     the data to its original form. 
        Any changes you make to the 
        data do not become permanent 
        until you save the file. Any edited 
        and saved values are displayed in 
        red whenever the data files are 
        loaded in E-DataAid. We don’t 
        want to keep this change, so we 
        click Undo here.



51

E-Prime 2.0 Getting Started Guide 

Next we will configure the data for analysis using the Analyze command. Ultimately we want to create a table 
of reaction time means that show the average reaction time by condition. In order to do this, we need to specify 
the NameGender, PrimeGender, and PrimeType variables as the columns, and the Subject number variable as 
the row. Then we will need to select the Target.RT variable to calculate the reaction time data. 

Task 5: Analyze data

1)  Click the Analyze tool button, or
     select the Analyze command from
     the Tools menu.
        The Analyze dialog lists the
        variables available in the
        experiment. The tutorial
        experiment has three
        independent variables
        (NameGender, PrimeGender,
        PrimeType).

2)  In the Variables list, click
     NameGender and drag it to the
     Columns field. Add PrimeGender
     and PrimeType as columns using 
     the same process.
        If you drag the wrong variable
        name to one of the fields, you
        can remove it by dragging the
        variable back to the Variables list.

3)  Click Subject in the Variables list
     and drag it to the Rows field.

4)  In the Variables list, click Target
     .RT and drag it to the Data field.
        Target.RT, reaction time collected
        by the Target object, is the
        dependent measure, and will be
        summarized as a mean. The
        summary statistic may be
        changed by double clicking the
        variable in the Data field.

2
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Next we will name the analysis, and double check that we have everything set up the way we want it. Then 
we can run the analysis. Remember, we are only looking at the correct trials because of the filter we set up in  
Task 3. The Analyze dialog gives you the option to remove the filter before completing the analysis by clicking 
Filter... > Clear All > Close. You also have the option to save the analysis operations (.anl file) so you don’t have 
to do the setup part if you plan to use the analysis again (via the Load Analysis... button).

Task 5 (continued): Analyze data

5)  Type Mean RT by Condition in 
     the Name field as the title of the 
     analysis. Then double check that 
     your Analyze screen matches the 
     one shown here.

6)  Click Run to display the analysis
     in a table format.

7)  This is what the output will look like. 
     Remember we are looking at the 
     correct answers only, which is why 
     there are empty cells in the table.

5 

 6

 7
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Sometimes a visual representation of the data is easier to interpret. We will use Excel to plot the data from the 
analysis table so we can examine the data in graph form. In order to complete this step, you must have Excel 
installed on the computer you are currently using.

Task 6: Create an Excel plot

1)  Select the Plot option under 
     Display Mode.

2)  Click the Excel Plot button.
        E-DataAid launches Excel,
        copies the analysis table to a
        worksheet, and plots the data.
        You may need to click the Excel
        application to see it.

3)  Examine the table and plot
     created in Excel showing mean
     reaction time by condition for
     each participant.
        Target.RT, reaction time collected
        by the Target object, is the
        dependent measure, and will be
        summarized as a mean.

4)  Exit the Excel workbook without
     saving.

5)  Within E-DataAid, close the Table
     and Analyze dialogs.
        Analyses may be saved (Save 
        Analysis...) to be reloaded (Load 
        Analysis...) at a later time. 
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Sometimes it is necessary to perform more complicated statistics with your data, and it is helpful to have an 
easy way to export the data to an analysis package. The Export function in E-DataAid allows you to export 
your data into a tab (or other delimiter) delimited format (.txt) tailored for import into several different analysis 
packages including Excel and SPSS.

Task 7: Export data

1)  From the File menu in E-DataAid,
     select the Export command.
        The Export dialog is displayed
        offering various options for export.
        Note that only the displayed (i.e.,
        filtered) data will be exported.

2)  In the Export dialog, set the 
     “Export to” field to Excel and 
     select OK.

3)  In the Export As dialog, enter the
     filename to be ‘Exported Tutorial
     Data.txt,’ and click the Save 
     button.
        The data is exported to a
        tab delimited text file. In the 
        next step, we will import this file
        into another application.

 1
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Excel offers a statistical analysis package and many people are familiar with its basic operations. This is an 
example of how to import a data file. To import your data into another program please follow your software’s 
instructions on importing a tab (or other delimiter) delimited data file. Once the data is imported, you can use 
Excel’s functions and formulas to perform the desired statistical analyses, and/or plot the data.

Task 8: Import text file into Excel

1)  Open a new workbook in Excel, 
     and select Open from the File 
     menu.

2)  Navigate to ...My Experiments\
     Tutorials\Data\Exported Tutorial 
     Data.txt. Select Text Files so 
     Exported Tutorial Data.txt will be 
     listed in the file list.

3)  Select Exported Tutorial Data.txt 
     and click the Open button.
        This brings up the Text Import
        Wizard. The defaults in the wizard
        are set for delimited text
        separated by tabs.

4)  Step through the Text Import
     Wizard, accepting the default
     settings, or click Finish.
        Exported Tutorial Data.txt will be
        opened in an Excel spreadsheet,
        with header information indicating
        the location of the source file, and 
        a list of any active filters at the 
        time the data was exported.

5)  Exit Excel.

6)  Congratulations, you have
     completed the E-DataAid tutorial.
     You may close the E-DataAid
     application at this time. 
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Chapter 5: Advanced Tutorials
The E-Studio basic tutorials are designed to introduce various features and capabilities available
in E-Studio that will allow you to more effectively use it as an experimental design tool.
The Advanced Tutorials build upon the introduction of those basic skills. The Advanced Tutorial 
exercises will guide you through modification of the experiment created in the E-Studio tutorial 
in order to introduce some commonly used features of E-Prime. It is recommended that you 
work through the E-Studio tutorial, as well as all of the advanced tutorials, in order to generate 
the required experiment files and most effectively learn how to use E-Prime. The pre-created 
experiment files resulting from each tutorial are also included as part of the E-Prime installation
in the ...My Experiments\Tutorials\Data\Originals folder.

Picture Tutorial: 
Modify an existing experiment to use images rather than text stimuli.

Sound Tutorial:
Modify an existing experiment to present sound and text simultaneously.

Movie Tutorial:
Modify an existing experiment to present a movie in conjunction with text and sound.

Script Tutorial:
Add user-written script to an existing experiment.
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Advanced Tutorial 1: Modify Tutorial.es2 to present pictures

This tutorial is designed to walk you through the necessary steps to set up your Tutorial.es2 
experiment to display pictures. We will show you how to alter the Target object to present image 
files, and set its properties to display the images. Then we will demonstrate how to change your list 
to present the images. Finally, we will edit the Instructions to reflect the changes. When you have 
completed this tutorial you will have an experiment that shows images.
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1)  Within the E-Studio application,
     use Ctrl+O to Open Tutorial.es2.

2)  In the File menu, select the Save
     As command.

3)  In the Save As dialog navigate to   
     ...My Experiments, change the 
     File name field to ‘PictureTutorial,’ 
     and then click Save.

1 

2 

3 
3

3 

It is a good idea to preserve the original Tutorial.es2 that we have spent so much time on. In order to do this 
we will open the Tutorial.es2 experiment and save it as PictureTutorial.es2. This way we can make some 
modifications to the new file without altering the contents of the original Tutorial.es2 file.
      NOTE: If you have not gone through the entire Getting Started Guide and would like to complete this
      tutorial go to ...My Experiments\Tutorials\Data\Originals folder, and open the Tutorial.es2 file.

Task 1: Open Tutorial.es2 and save as PictureTutorial.es2
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We will now begin to transform the experiment to display image files in place of simple text.

Task 2: Replace SlideText with a SlideImage

1)  Open the Target object in the 
  Workspace. Use the dropdown 

     menu on the Slide toolbar to 
     select the text sub-object. Right 
     click and select Delete to delete 
     the Text1 sub-object from the 
     Slide.

2)  Click the SlideImage button on
     the toolbar, then click anywhere
     within the active SlideState
     window.
        An image sub-object will appear 
        in the Slide window. The picture 
        will be gray because no file has 
        been selected yet.

3)  Click the green Sub-Object
     Property Pages button.

4)  On the General tab, enter [Target] 
     in the Filename field, for Stretch 
     select Yes, and for Stretch Mode 
     select UpDown.

5)  On the Frame tab for the image, 
     set the Width to 50% and the 
     Height to 75%. Set the X and Y 
     Position properties to center. 

6) Click OK to accept the settings.
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Now we will edit the properties of the Slide to show images for ten seconds, verify that the input device is the 
keyboard, and double check the data logging, allowable responses, correct answer setting, and end action.

Task 3: Specify the properties of Target

1)  Click the white Property Pages 
     button to view the properties of the 
     Target object.
        You are now viewing the
        properties of the Slide.
        NOTE: The Property Pages
        button is used to set the 
        properties of the entire object 
        (e.g., duration, input masks, etc.)
        while the green Sub-Object 
        Property Pages button is used to 
        set the properties of individual 
        sub-objects.

2)  On the Duration/Input tab, verify
     the following:
        •   Duration is set to 10000ms
        •   Data Logging is set to
            Standard
        •   The Keyboard is enabled as
            the Input Device
        •   The Allowable field is set to 
            “12”
        •   The Correct field references
            [CorrectAnswer]
        •   Time Limit is set to (until 
            feedback)
        •   End Action is set to 
            Terminate

3)  Click the OK button to close the
     Property Pages.
        This takes you back to editing 
        the Target object in the  
        workspace.
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We will now modify the TrialList to display images instead of text. The first thing you should do is copy the 
...My Experiments\Tutorials\female.jpg and male.jpg image files into the same folder you are currently saving 
your .es2 file. We will modify the Target Attribute which currently contains male or female names, to reference 
the female.jpg and male.jpg images. E-Prime is capable of presenting additional image formats as well (e.g., 
JPEG, PNG, BMP). For more information please refer to the SlideImage sub-object topic in the E-Prime 
Reference Guide.

Task 4: Modify the List object

1)  Using Windows Explorer, copy
     the ...My Experiments\Tutorials\
     female.jpg and male.jpg to the
     same folder where you are
     currently saving your .es2 file. 
        NOTE: You can put your files 
        elsewhere as long as you set the 
        correct path to them in the 
        experiment. However, when all 
        of the resources for an 
        experiment are in the same folder 
        or subfolder as the .es2 file it is 
        easier to move the experiment 
        without leaving any necessary 
        files behind.

2)  Double click the TrialList to Open 
     it in the Workspace.

3)  Modify the Target Attribute
     values to match those in the 
     TrialList to the right. 

4)  In the Prime Attribute column,
      change “bald” to “cigars”.

5)  Press Ctrl+S to save your work 
	   before continuing.
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Since we have changed the experiment, we will need to edit the Instructions to reflect those changes; the 
Target stimulus is now a picture rather than text. Now when the Target stimulus is presented, a figure of either 
a male or a female will be displayed. We will replace the Instructions text to read: “Welcome to the experiment. 
You will see a priming word followed by a fixation. A picture will follow the fixation. Your task is to determine if 
the picture was a male or female image. Press the “1” key for a male image and “2” for a female image. PRESS 
THE SPACEBAR TO BEGIN!”

Task 5: Edit the Instructions

1)  Open the Instructions object in
     the Workspace.

2)  Edit the text to read: “Welcome to
     the experiment. You will see a
     priming word followed by a
     fixation.  A picture will follow the
     fixation. Your task is to
     determine if the picture was a
     male or female image. Press the
     “1” key for a male image and “2” 
     for a female image. PRESS THE
     SPACEBAR TO BEGIN!” 

3)  Verify that your experiment
     structure matches that to the right.
     Save the PictureTutorial
     experiment.
        NOTE: The necessary images 
        are located in the 
        ...My Experiments\Tutorials folder. 
        These images must be saved in 
        the same folder as 
        PictureTutorial.es2.

4)  Press F7 to Run the experiment.
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Advanced Tutorial 2: Modify PictureTutorial.es2 to present sound

This tutorial is designed to walk you through the necessary steps to set up your PictureTutorials.es2 
experiment to include a sound with the Prime object. We will show you how to alter the Prime and 
TrialList objects to present text and sound files simultaneously. Then we will edit the Instructions to 
reflect the changes. When you have completed this tutorial you will have an experiment that uses a 
Slide object to prime the participant with text and sound before the Target object presents the stimulus. 
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1)  Open PictureTutorial.es2 in
     E-Studio.
        For instructions on how to open 
        an experiment refer to Advanced 
        Tutorial 1, Task 1 in this manual.

2)  In the File menu, select the Save
     As command.

3)  In the Save As dialog, change the 
     File name field to ‘SoundTutorial’ 
     and then click Save. 

 

3 3

 2

The SoundTutorial experiment that we will create is based on the PictureTutorial experiment. It is a good idea 
to preserve the original PictureTutorial.es2. In order to do this we will open the PictureTutorial.es2 experiment 
and save it as SoundTutorial.es2 in the folder you are currently working in. This way we don’t have to start an 
experiment from the beginning; we can simply modify the new file without altering the contents of the original 
PictureTutorial.es2 file.
      NOTE: If you have not gone through the entire Getting Started Guide and would like to complete this
      tutorial go to ...My Experiments\Tutorials\Data\Originals folder, and open the PictureTutorial.es2 file.

Task 1: Open PictureTutorial.es2 and save as SoundTutorial.es2
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The first thing we need to do is add an object that is able to perform multiple functions at the same time: a Slide 
object. To do this, we will drag and drop a Slide object into the workspace. This will create a Slide object in the 
Unreferenced E-Objects. Later, we will replace the current Prime object with the new Slide, and configure it to 
present the Prime as both text and sound.

Task 2: Create a Slide object

1)  Click the Slide object in the
     Toolbox and drag it to the
     Workspace.
        A new Slide object will be created 
        in the Workspace and will 
        appear in the Structure window, 
        Unreferenced E-Objects 
        folder.

2)  Highlight the Slide, then press 
     F2 to rename the Slide object 
     SoundPrime.

1 

 2
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Now we will add a text sub-object to the SoundPrime to present text.

Task 3: Add text to the SoundPrime Slide object

1)  Click the SlideText button on the
     toolbar, then click anywhere within
     the active SlideState window.

2)  Select the Text1 sub-object 
     and click the green Sub-Object 
     Property Pages button to display 
     its properties.
        There may be many sub-objects
        composing a Slide. Select the
        desired sub-object to set the
        appropriate properties.

3)  On the General tab, enter [Prime]
     in the Text field to indicate that the
     text to be displayed will vary
     according to the Prime Attribute
     (from the TrialList).
        For more information on Attribute
        references, refer to the Attribute
        topic in the E-Prime Reference
        Guide.

4)  Select the Frame tab and set the
     X - and Y - Position properties to
     center. 

5)  Click OK to accept the settings.

6)  Select the default Slide State,
     click the green Sub-Object 
     Property Pages button.

7)  Select the Frame tab and edit the
     Width and Height to be 100%.

8)  Click OK to accept the settings.
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Now we must double check that the experiment is enabled to use sound. First we will open the Experiment 
Property Pages window, and click the Devices tab. Then we simply confirm the checkbox next to the Sound 
Device is checked. E-Prime 2.0 allows for a number of Devices to be added to your experiment. 
      NOTE: You can display a list of these Devices by clicking the Add... button. Once you have selected and
      added the new device to the Experiment Property Pages, all supported devices can be enabled as an input
      device on the Duration/Input tab of any object collecting a response. For more information on adding an
      input device at the experiment level, please refer to the Duration/Input topic in the E-Prime Reference
      Guide.

Task 4: Enable the Sound Device

1)  Double click the Experiment 
     object at the top of the Structure 
     window and select the Devices 
     tab from the Property Pages.

2)  Confirm the checkbox next to 
     Sound is checked.

3)  Click OK to dismiss the 
     Experiment Object Property 
     Pages.

1 
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Next we will add a sound sub-object to the SoundPrime object, and configure it to present sound stimuli 
simultaneously with the [Prime] text.

Task 5: Add sound to the SoundPrime object

1)  Click the SlideSoundOut button
     on the toolbar, then click
     anywhere within the active
     SlideState window.
        A sound sub-object will appear
        in the Slide window. The sound
        sub-object will not be visible at
        runtime, and can be placed 
        anywhere on the Slide itself.

2)  Select the SoundOut1
     sub-object and click the green
     sub-object Property Pages
     button.

3)  On the General tab, set the 
     Filename field to [SoundFile].
        The SoundFile Attribute will be 
        added to the TrialList in a future
        step. The filename for the sound 
        sub-object will be resolved by
        this Attribute when you run your     
        experiment.

4)  Click OK to close the Property 
     Pages, and press Ctrl+S to save 
     your work before continuing.
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Next we will configure the properties of the SoundPrime object. The white Property Pages button is used to set 
the properties of the entire object, e.g., object duration, input masks, etc., while the green Sub-Object Property 
Pages button is used to set the properties of the selected sub-object, such as the SoundOut sub-object’s 
filename.

Task 6: Specify the properties of SoundPrime

1)  Click the white Property Pages 
     button to set the properties of the
     SoundPrime object.

2)  On the Duration/Input tab, set the
     Duration to 1500ms.

3)  When you are finished, click the
     OK button.
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Next we need to replace the Prime object with the new SoundPrime Slide object. When the Prime object is 
deleted, it will be listed in the Unreferenced E-Objects folder. Objects that are no longer referenced on any 
Procedure in the experiment structure are moved to the Unreferenced E-Objects folder, rather than being 
deleted. This allows those objects to be used at a later time without having to recreate them. The Prime object 
is no longer going to be used in this experiment. Deleting an object from the Unreferenced E-Objects folder 
removes it from the experiment completely. You will always receive a prompt asking you to verify this action 
before it occurs. 

Task 7: Add SoundPrime to the trial procedure

 2
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1)  Double click the TrialProc to open 
     it in the Workspace.

2)  Drag the SoundPrime object from   
     the Unreferenced E-Objects 
     folder in the Structure window, 
     to the right of the Prime object. 
        When dragging an object, arrows 
        will indicate where the object will 
        be placed when it is dropped.

3)  On the TrialProc click the Prime
     object to select it.

4)  Delete the Prime object from the
     TrialProc.
        Press the Delete key, or right click
        on the object after selecting it and
        choose the Delete command from
        the context menu that appears.

5)  Notice that Prime object is now 
     listed in the Unreferenced 
     E-Objects folder. Delete the Prime
     object from the Unreferenced
     E-Objects folder.
        NOTE: Deleting an object from
        the Unreferenced E-Objects
        folder removes it from the
        experiment completely. You will
        always receive a prompt asking
        you to verify this action before it
        occurs. 
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Now we will add the SoundFile Attribute to the TrialList. This Attribute will determine which sound file will be 
played in conjunction with a particular visual stimulus. In this example, the visual stimulus will be female.jpg or 
male.jpg.

Task 8: Modify the List object

1)  Use Windows Explorer to copy the
     ...My Experiments\Tutorials\
     sports.wav, laundry.wav, 
     flowers.wav, and cigars.wav files
     into the same folder you are
     currently saving your .es2 file.

2)  Double click the TrialList in 
     Structure window to open it in the 
     Workspace.

3)  Use the Add Attribute tool button
     to add an Attribute called
     SoundFile. Click Add to accept.

4)  Enter the names of the .wav files
     as values for the SoundFile 
     Attribute as shown in the TrialList 
     to the right.
        The audio files used in this tutorial 
        are included in the 
        ...My Experiments\Tutorials folder 
        as part of the E-Prime installation. 
        Copy these files to your current
        working folder.

5)  Remember to save periodically.

3 

 3  3

 5
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Finally, we will edit the Instructions to explain that a word will be spoken through the speakers at the same time 
that the [Prime] word appears.

Task 9: Edit the Instructions

 

3

 

3

1)  Double click the Instructions 
     object in Structure window to
     open it in the Workspace.
        NOTE: You can edit the text by
        typing directly into the Instructions
        object.

2)  Edit the Instructions to be relevant
     to the modified program.  
        Use the text from image on 
        the right as a guide.

3)  Verify that your experiment
     structure matches that to the
     right. Save and Run the
     SoundTutorial experiment.

3

 1

2
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Advanced Tutorial 3: Modify SoundTutorial.es2 to present a movie

This tutorial is designed to walk you through the necessary steps to set up your SoundTutorial.es2
experiment to include a movie with the Prime object. We will show you how to alter the Prime 
and TrialList objects to present text, sound and movie files simultaneously. Then we will edit the 
Instructions to reflect the changes. When you have completed this tutorial you will have an experiment 
that uses the changes we have made to the Slide object to prime the participant with text, sound, and 
movie stimuli before the Target object presents the stimulus.
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1)  Open SoundTutorial.es2 in 
     E-Studio.
        For instructions on how to open 
        an experiment refer to Advanced 
        Tutorial 1, Task 1 in this manual.

2)  In the File menu, select the Save
     As command.

3)  In the Save As dialog, change the 
     File name field to ‘MovieTutorial’ 
     and then click Save.

2 

 3  

3

 3

The MovieTutorial experiment that we will create is based on the SoundTutorial experiment. It is a good idea 
to preserve the original SoundTutorial.es2. In order to do this we will open the SoundTutorial.es2 experiment 
and save it as MovieTutorial.es2 in the folder you are currently working in. This way we don’t have to start an 
experiment from the beginning; we can simply modify the new file without altering the contents of the original 
SoundTutorial.es2 file.
      NOTE: If you have not gone through the entire Getting Started Guide and would like to complete this
      tutorial go to ...My Experiments\Tutorials\Data\Originals folder, and open the SoundTutorial.es2 file.

Task 1: Open SoundTutorial.es2 and save as MovieTutorial.es2
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Next we will move the text sub-object so that it can be displayed above the movie sub-object when the movie is 
added to the Slide in the next step.

Task 2: Change the position of the text on the Slide object

1)  Double click the SoundPrime  
     object in Structure window to
     open it in the Workspace.

2)  Select the text sub-object and
     click the green Sub-Object
     Property Pages button on the
     Slide toolbar.

3)  Select the Frame tab, set the 
     Width to 25%, Height to 25%,
     X to center and the Y to 25%. 

4)  Click OK to accept the settings.

 3

 3

 4
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Now we will rename the SoundPrime object to MoviePrime. Then we will add a movie sub-object to the 
MoviePrime object. This will allow a movie to be presented along with text and sound.

Task 3: Add a movie to the Slide object

1)  Click the SoundPrime object in the 
     Structure window, then press F2 to        
     rename the object to MoviePrime. 
        The object is being renamed
        MoviePrime to reflect the fact that
        the prime will now be presented
        as a movie, along with text and
        sound.

2)  Click the SlideMovie button on the
     toolbar, then click anywhere
     within the active SlideState
     window.
        A movie sub-object will appear in 
        the Slide window.

3)  Select the movie sub-object and
     click the green Sub-Object
     Property Pages button on the
     Slide toolbar.

4)  On the General tab, set the
     Filename field of the movie sub-
     object to refer to [MovieFile], and
     set the Stretch property to Yes.
        The MovieFile Attribute will be
        added to the TrialList in the next
        step. The filename for the movie
        sub-object will be determined at
        runtime.

5)  On the Frame tab, set the
     Width and Height to 50%.
     Set the X- Position to center, and
     the Y- Position to 55%.

6)  Click OK to accept the settings.

 4

 4
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Now we will configure the MoviePrime object properties.

Task 4: Specify the properties of MoviePrime

 1

 2

 3

1)  Click the white Property Pages 
     button to set the properties of the 
     MoviePrime object.
     NOTE: The sound icon may
     disappear behind the slide movie,
     this will not effect the experiment’s
     functioning.

2)  On the Duration/Input tab, set the
     Duration to 3000ms.

3)  When you are finished, close the
     Property Pages by clicking the
     OK button.

4)  Press Ctrl+S to save your 
     experiment.
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We will now modify the TrialList to display movies by adding the MovieFile Attribute. The first thing you should 
do is copy the ...My Experiments\Tutorials\sports.mpg, laundry.mpg, flowers.mpg, and cigars.mpg files into 
the same folder you are currently saving your .es2 file. E-Prime 2.0 is capable of presenting additional movie 
formats (e.g., WMV, MPEG-1, DIVX). For more information, please refer to the MovieDisplay object topic in the 
E-Prime Reference Guide.

Task 5: Modify the List object

1)  Use Windows Explorer to copy 
     the ...My Experiments\Tutorials\
     sports.mpg, laundry.mpg, 
     flowers.mpg, and cigars.mpg files
     into the same folder you are
     currently saving your .es2 file. 

2)  Double click the TrialList to open 
     it in the Workspace.

3)  Click the Add Attribute button. In   
     the Name text box type MovieFile. 
     Then click the Add button to add 
     the Attribute to the TrialList object.

4)  Enter the names of the movie files
     to present as values for the
     MovieFile Attribute as shown in
     the TrialList to the right.

3 

 

4

 3  3
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Finally, we will edit the Instructions to explain that a movie will play simultaneously with the Prime text and 
audio file.

Task 6: Edit the Instructions

1)  Open the Instructions object in
     the Workspace.

2)  Edit the Instructions to be relevant
     to the modified program by typing
     directly into the Instructions object.
        Use the text from image on 
        the right as a guide.

3)  Verify that your experiment
     structure matches that to the
     right. Save and Run the
     MovieTutorial experiment.

 

3

 

3
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Advanced Tutorial 4: Modify MovieTutorial.es2 to use E-Basic script

This tutorial will introduce you to writing script. You will enter script into an InLine object in E-Studio 
which will introduce a delay between the Prime and the Target objects. During the delay we will 
present a circle that is gradually drawn in sections. The duration of the delay will be varied by 
manipulating the rate at which the sections are drawn.

This is NOT a complete tutorial on how to write script. If you would like more help with scripting in your 
own experiments, see E-Basic Help or refer to the chapter titled, Using E-Basic in the 
E-Prime User’s Guide. 

Follow the steps below to access E-Basic Help directly from E-Studio. 

	  Select E-Basic Help from the Help menu in E-Studio.

	  The E-Basic Help Welcome screen provides quick links to topics frequently referenced by
	   technical support in response to user’s requests, instructions for using E-Basic Help, and
 	   other helpful information. Use the Contents, Index, and Search tabs to locate specific Help
	   topics.
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    The ScriptTutorial that we will create is based on the MovieTutorial experiment. It is a good idea to preserve 
the original MovieTutorial.es2 file. In order to do this we will open the MovieTutorial.es2 experiment and 
save it as ScriptTutorial.es2 in the folder you are currently working in. This way we don’t have to start an 
experiment from the beginning; we can simply modify the new file without altering the contents of the original 
MovieTutorial.es2 file. 

         NOTE: If you have not gone through the entire Getting Started Guide and would like to complete this
         tutorial go to ...My Experiments\Tutorials\Data\Originals folder, and open the MovieTutorial.es2 file.

Task 1: Open MovieTutorial.es2 and save as ScriptTutorial.es2

1)  Open MovieTutorial.es2 in
     E-Studio.
        For instructions on how to open 
        an experiment refer to Advanced  
        Tutorial 1, Task 1 in this manual.

2)  From the File menu, select the 
     Save As command.

3)  In the Save As dialog, change the 
     File name field to ‘ScriptTutorial’ 
     and then click Save.

 3  3

 3

2 
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1)  Open the TrialProc in the
     Workspace.

2)  Click the InLine object in the
     Toolbox and drag it to the right of
     the Fixation object on the
     TrialProc.

3)  Click on the InLine1 object and 
     press F2 to rename InLine1 as 
     CountdownClock.

4)  Select the Fixation object, right
     click, and select Delete to remove
     the object from the TrialProc.

5)  Notice that Fixation is now listed
     in the Unreferenced E-Objects
     folder.
        Objects that are no longer
        referenced on any Procedure
        in the experiment structure are
        moved to the Unreferenced
        E-Objects folder rather than being
        deleted. This allows those objects
        to be used at a later time without
        having to recreate them.

6)  Delete Fixation from the
     Unreferenced E-Objects folder.
        The Fixation object is no longer
        going to be used in this
        experiment. Deleting an object
        from the Unreferenced E-Objects
        folder removes it from the
        experiment completely. You will
        always receive a prompt asking
        you to verify this action before it
        occurs. 

7)  Save the experiment.

In this task we will create an InLine object and name it CountdownClock. The purpose of the CountdownClock 
InLine object is to create a delay between the Prime object and the Target object. We will also replace the 
Fixation with the CountdownClock InLine object.

Task 2: Create an InLine object

 3

1 

  2
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 7
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Now we will copy some script from E-Basic Help and paste it into the CountdownClock InLine to introduce a  
visual delay between the Prime and the Target.

Task 3: Add script to the CountdownClock InLine

1)  From the Help menu, select
     E-Basic Help to view the E-Basic
     Help Welcome Screen.

2)  Click the Search tab located in the
      Help window.
        The Search tab allows you to
        search for specific words or 
        phrases within the Help topics.

3)  Type “Script Tutorial” in the
     search box and click the List 
     Topics button.

4)  Find and select “Script Tutorial” 
     in the list of topics and click the 
     Display button. 
        Help topics are composed of 
        various sections, usually including
        the title of the topic, a description,
        comments, and a working
        example.

5)  Under the “Example” heading,
     select all of the text and right-
     click to copy.
        NOTE: Do not include the See
        Also section when copying and
        pasting the script.

6)  In E-Studio, double click the
     CountdownClock InLine object, 
     right click and select Paste to 
     copy the script into the InLine.

7)  Save the experiment.

 6
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 3

 4

 1
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1)  Examine the script in the
     CountdownClock InLine object.

2)  Locate the Random function in the
     CountdownClock InLine.
        The Random function and 
        subsequent ‘If...Then’ conditional 
        is used to randomly select a 
        value, then use that value to 
        assign the duration of the delay 
        (either 500ms or 1000ms). The 
        delay value determines the speed 
        at which the clock sections are 
        drawn, thus determining the total 
        delay duration. 

3)  Locate the c.SetAttrib command
     in the script.
        The c.SetAttrib command is used
        to log the value of the delay
        (i.e., the entire delay between the
        prime and the target) as an
        Attribute in the data file. Script 
        variables are not automatically 
        logged in the data file unless they 
        are set as Attributes.

4)  Locate the Debug.Print command
     in the script.
        The Debug.Print command is
        used to send a string to the 
        Debug tab in the Output window.
        In this example we are sending          
        the value of the delay, nDelay.

This task will explain the script used to display the delay between the Prime and the Target.
      NOTE: The Canvas object is a scripting object used in this tutorial to display the delay, but is not explained  
      in detail here. Refer to the Canvas topic in the E-Basic Help for further information.

Task 4: Examine the script in the CountdownClock InLine
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Next we will examine the information sent to the Output window by the Debug command.

Task 5: View the results of the script in the Output window

1)  Run the experiment.
        With the script that was 
        introduced in Task 3, a circle 
        is gradually drawn in sections, 
        introducing a delay between the 
        prime and the target.

2)  In the View Menu, verify that the 
     Output tab has a check next to it.
        By default, the Output window
        appears at the bottom of the
        application window.

3)  Select the Debug tab to View the 
     output. 
        The Debug.Print command prints
        the value of the delay occurring 
        on each trial to the Output window 
        (i.e., random selection of 500ms 
        or 1000ms). 

 

1

 3

 2
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Next we will open the data file in E-DataAid and view how the Delay Attribute was logged. 

Task 6: Examine the logging of the Delay Attribute in the data 
file

1)  Select Tools > E-DataAid to open 
     E-DataAid. Press Ctrl+O to 
     activate the open file dialog.
        Chapter 4: E-DataAid in this
        manual provides additional
        information about the E-DataAid
        application.

2)  Select the 
     ScriptTutorial-1-1.edat2 data file
     and click Open.
        Assuming that the default 
        participant and session number 
        are used, the data is collected in 
        a file named 
        ScriptTutorial-1-1.edat2. 

3)  Scroll to the right in the
     spreadsheet to find the Delay
     column.
        This column shows the value of 
        the Delay Attribute on each trial. 
        While the Debug.Print command 
        is useful as a quick reference 
        when developing an experiment in 
        E-Studio, the c.SetAttrib
        command logs the value in the
        data file, which of course is useful
        as a record of the experimental
        run and in later data analysis.

4)  Close E-DataAid.

5)  Close E-Studio.

 1
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When implementing a new experiment, it is helpful to conceptualize an experiment before 
jumping into object creation and script writing. A bit of preparatory effort will result in quicker 
implementation and more efficient design, with fewer bugs and forgotten measures. The following 
are recommendations for good practices when implementing and testing an experiment in 
E-Prime. A list of available resources for help is also included.

Conceptualize the experiment
•    Have a clear idea of the questions you wish to answer in your research.
•    Determine what variables and procedures are necessary to answer these questions, what
     data must be collected, and how the data will be analyzed. This will save time and create better
     research.
•    Prior to implementing anything in E-Studio, storyboard the events of the trial procedure that will
     be used to collect the data on paper.
•    State the expected effect the independent variables might have on the dependent variables.
     It is useful to write an abstract for the experiment, particularly detailing the procedure.

Design the experiment
•    Be able to specify the design of the experiment and list all of the conditions, stimuli, and
     expected responses.
•    Use the storyboard to translate each event into an object in E-Studio.
•    Start with the basic design, implement it, and then elaborate on it.
•    Design the experiment in small stages, each containing a few steps. Implement and test that
     stage before implementing the next stage.

Test the experiment
•    Save often and test the experiment as you go.
•    Begin by testing only a few trials before completing full stimulus lists and instructions.
•    Once the basic trial is running and data are logged correctly, add additional variables, stimuli,
     instructions, and other details. Test again!
•    While testing, it may useful to be able to exit an experiment without having to complete all of the
     trials. To terminate an experiment before its normal completion, use the Ctrl+Shift+Alt key
     combination (hold down all at once). This will terminate the E-Run application.
          A dialog will be displayed asking if you are sure you want to terminate the run. Click Yes
          and another dialog will indicate that the run was terminated early. Simply dismiss the 
          second dialog by clicking OK.

NOTE: When an experiment is terminated early, no .edat2 file is written. Early termination should 
only be used during testing, and when the logging of data is not being examined.
     
     For more information on conceptualizing and designing an experiment, refer to Appendix B:
     Considerations in Research in the E-Prime User’s Guide.

Chapter 6: Good Practices, Testing, & Help
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The E-Prime manuals and resources provide valuable information and exercises to learn and make 
use of the flexibility and power of E-Prime.

E-Prime Manuals
•    The E-Prime Getting Started Guide, User’s Guide and New Features/Reference Guide are
      included in the E-Prime installation and are installed as PDF files.
•    The PDF files may be accessed from the Windows Start Menu > All Programs > E-Prime 2.0 > 
      Documentation, or Help > Documentation menus. They are also available for download via the 
      PST Product Service and Support site (see PST Product Service and Support site below).

E-Basic Help
•    E-Basic Help topics describe the use of all E-Basic statements, functions, commands, and
      objects, and the syntax and parameters required for each. Each Help entry addresses any
      considerations specific to the topic, some working examples, and a listing of direct links to 
      related topics.
•    E-Basic Help may be accessed from the E-Prime folder via the Start menu through the Help 
      menu within E-Studio.

E-Prime Professional Feature: ScriptSense™
E-Prime Professional includes a script completion and editing tool, which provides:
•    Automatic completion of commands and context-sensitive information 
•    An extensive set of short-cut keys to access a variety of useful editing functions
•    Automatic support when creating or editing E-Basic script

E-Prime web site
The E-Prime product web site includes product information, as well as links to FAQs, PST Product 
Service and Support, and the PST User Forum. Visit www.pstnet.com/eprime.cfm.

PST Product Service and Support site
•    The Product Service and Support site provides the latest updates, a Knowledge Base section, 
      samples, downloads, and a personal support interface to communicate with PST support
      representatives.
•    Installation support for E-Prime can be obtained through PST Product Service and Support by 
      visiting www.pstnet.com/support, or by calling PST at 412-449-0078.
•    General support for E-Prime is handled via the web only. Please submit your questions as 
      a request on the support site. Visit www.pstnet.com/support.

PST User Forum
•    The PST User Forum is set up to allow end users of PST products to ask questions and share
      information, tips, and samples with their peers.
•    Please visit www.pstnet.com/forum. Registration is required to post to the forum and download 
      attachments, but not to view topics.

E-Prime Help & Resources
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Chapter 7: Troubleshooting
This section serves as a tutorial for debugging and troubleshooting errors during the development 
and running of your E-Prime experiments. Technical assistance is available via PST Product 
Service and Support at www.pstnet.com/support and through the PST User Forum at 
www.pstnet.com/forum. Please keep in mind the screen captures and exact line numbers will vary 
depending on if you are using E-Prime 2.0 Standard or E-Prime 2.0 Professional. All illustrations 
were created with E-Prime 2.0 Professional using a Standard .es2 file.
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This task will introduce a compile error by asking the Feedback object to provide feedback for an object that is 
not capable of collecting the required statistics.

Task 1: Generate a compile error

1)  Open E-Studio and load the
     Tutorial.es2.

2)  Double click the Feedback object
     in the Structure window to open it
     in the Workspace.

3)  Click the white Property Pages 
     button to display the properties 
     for the Feedback object.

4)  Change the Input Object Name
     field from Target to BlockList by
     typing directly in the field, and
     click OK.
        A List object does not collect
        accuracy (ACC) or reaction time
        (RT) stats. This step will cause an
        error to be generated.

5)  Click the Generate button to
     produce the compile error.
        When a compile error is
        generated, an error dialog is
        displayed.

6)  Click OK to dismiss the dialog.

7)  Examine the Compile Error
     dialog.
        The error dialog indicates the
        line in the script at which the
        error occurred, and briefly
        describes the cause of the error.
        In this case, the BlockList object
        is not capable of collecting 
        responses from input devices so
        feedback on responses 
        (accuracy or response time) 
        cannot be provided. The line
        numbers may differ based on the
        version of E-Prime you are using. 

 1
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This task will describe another method of viewing the compile error and locating the line of script that caused 
the error.

Task 2: View the compile error

1)  Notice that upon receipt of the
     compile error both the Output
     and Script windows open
     automatically in E-Studio.
        The Script window opens in the
        Workspace. The Output window
        open at the bottom of the display.

2)  In the Output window, view the
     compile error on the Debug tab.
        The Generate tab provides details
        concerning the status of the
        compile operation. The Debug tab
        shows information specific to
        errors as well as any 
        Debug.Print message placed in
        the script by the user.

3)  Click in the Script window to
     switch the focus to this window,
     then press Ctrl+G.
        A Go To Line dialog will appear.

4)  Enter the line number listed in the
     error message and click OK.
        The line number you see may 
        differ from the one shown on the 
        right. The cursor will be placed 
        in the Script window, and will be 
        blinking at the line at which the 
        error occurred. 

 1

 1
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This task will edit the properties of the Feedback object to correct the compile error.

Task 3: Correct the compile error

1)  Double click the Feedback object 
     that was opened previously in the 
     Workspace.

2)  Click the Property Pages button to
     view the properties of the
     Feedback object.

3)  On the General tab, reset the 
     Input Object Name field to Target 
     and click OK.

4)  Click the Generate button to
     regenerate the script and ensure
     that the error has been eliminated.
        A successful compile operation
        results in a “successful” message
        displayed on the Generate tab in
        the Output window.

5)  Close the Feedback object and
     Script windows in the Workspace.

 5
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This task will introduce a Runtime error by asking the Target object to display the value for an Attribute that 
does not exist.

Task 4: Generate a Runtime error

 1

 5

 3

 2

1)  In the Structure window, double
     click the Target object to open it.
        The Target object is used to
        display the values of the [Target]
        Attribute.

2)  Edit Target to display [Tarfet]
     instead of [Target].
        Spelling errors are the most
        common causes of errors within
        E-Prime. Always double check
        your typing, especially in the
        List object.

3)  Click the Run button to generate
     and run the script.

4)  Accept the default values in the
     subject initialization and startup
     dialogs to begin the experiment.
        NOTE: Unlike the compile error, a
        runtime error does not occur
        during generation. The runtime
        error will occur when the affected 
        script is encountered at runtime.

5)  Examine the Runtime error. 
        The error occurred because the 
        Attribute [Tarfet] does not exist.

6)  To eliminate the error, correct the
     spelling error.

7)  Save and rerun the experiment to
     ensure the error has been
     corrected.

8)  Congratulations! You have
     completed all the tutorials in the
     Getting Started Guide. 
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